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Welcome to Stay Organized Quick & Easy!

Thank you for purchasing Stay Organized Quick & Easy.  This file contains additional 
information on Stay Organized Quick & Easy that may be of use and may not be in the 
manual or Help system.  You should refer to the Stay Organized Quick & Easy Help system 
and manual for more complete information.
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System Configuration

Stay Organized Quick & Easy requires:

• Microsoft Windows 3.1 or higher -  Microsoft Windows 3.1 or higher must be able 
to run properly for Stay Organized Quick & Easy to operate.

• PC/AT 386 compatible computer - Your computer needs to be based on an Intel 80386, 
80486, or Pentium CPU.

• 3MB RAM available - Windows needs to be setup such that by the time you are 
ready to run Stay Organized Quick & Easy, the Program Manager reports your 

memory to have 3,000 KB free.
• VGA or higher display - You need to have a VGA or higher display setup in 

Windows (e.g., Super VGA).
• Hard Drive with 3MB space available - Stay Organized Quick & Easy occupies 

approximately 3MB of disk space once installed.

Upgrading From Another Personal Organizer

1. Use your current personal organizer to Export or save your data as a Comma-
separated-value file (.CSV) or a Tab-delimited (.TXT) text file.  Consult your 

specific personal organizer's manual or On-Line help for details on how this 
may be accomplished.
2. After installing Stay Organized Quick & Easy, choose Import from the File menu and

select the newly created .CSV or .TXT file.
3. Follow the instructions provided in the Stay Organized Quick & Easy User's Guide 



on Help System for importing files

Printing Tips

1.   Stay Organized Quick & Easy supports the use of any font available through Windows.  
True Type fonts are recommended for the best quality preview and printouts.

2.   To use pre-sized organizer and pocket-sized paper with a laser printer, your printer 
should have a manual sheet feeder.  For the best print alignment, select your brand of 
organizer paper by choosing Page Setup... from the File menu.  For complete 
instructions, refer to Page Setup in Stay Organized Quick & Easy Help.

3.   For dot-matrix printer users, if you have a choice between using tractor-feed or friction-
feed paper, tractor-feed paper is recommended.  However, you may need to use friction-
feed paper for pre-sized organizer paper.

Refer to your printer manual for information on: proper paper alignment, emulated printers, 
setting printer emulation, paper feed options, envelope printing, and other printer-specific 
information.

Printing

Customizing Layouts
Stay Organized Quick & Easy has more than 50 possible layouts you can select.  You can 
also customize each layout with a variety of choices including header/footer text, fonts, 
colors, borders, and shading.  To customize a layout, choose Options in either the Layout 
menu or the Layout entrybar.

Layouts in Stay Organized Quick & Easy are shared by all Stay Organized Quick & Easy 
files.  If you customize a layout, the changes you make will apply every time you use that 
layout, regardless of which file you are using.

“Memory Overflow” Printer Error
More complex layouts (numerous fonts, multiple colors, etc.) can require substantial printer 
memory.  Reducing the number of fonts and colors, will reduce the memory required to print 
the layout.  You may also be able to reduce the resolution of the printer to conserve printer 
memory.  For laser printers a full page 300 DPI layout generally requires your printer to have 
at least 1MB of memory installed.  If you laser printer has only 512k then layouts may not 
print properly.  Use the Control Panel to set printer resolution, or Print Setup in Stay 
Organized Quick & Easy.

Printing Groups Of Events
Turn on Group Filtering and select the groups you want to print.  Print the layout normally. 
Only events and addresses in the selected groups will print.

Print Quality
Black and white printers will print all colors in gray scale.  The quality of the gray scale will 
depend on the printer being used.  Use of the Gray Scale shading options may produce 



better quality.

Laser printers and many dot-matrix printers have more than one resolution they can use.  
Use the Control Panel to set the default printer, printer resolution, and other printer options.  
You can also use Print Setup in Stay Organized Quick & Easy to change printer options while
using Stay Organized Quick & Easy.

Using color printers
Make sure the printer driver you have selected through Windows is the correct one for your 
printer.  Color printers may also need to have additional options set for controlling colors and 
print quality.  Check these settings to make sure the color option is on.

Some color printers have multiple color reservoirs: black, red, yellow, and blue.  The printer 
settings for using color may need to be adjusted to achieve the best text and color quality.  
Printer settings that optimize the use of the color black typically produce the best quality 
layouts.

Using Preprinted Organizer Paper
Stay Organized Quick & Easy can print on a variety of sizes of organizer paper.  Select Page
Setup and select the type of paper being used for each layout size, and where to print on the 
page.

Day Planner / Address Book

Birthdays and Anniversaries
Birthdays and anniversaries can be entered into the Address Book.  When entered, Stay 
Organized Quick & Easy will ask if you want to add these as events in the Day Planner.  If 
you say yes, Stay Organized Quick & Easy will place a yearly repeating event for the 
birthday or anniversary starting from the current date for a span of 20 years.

Copying Events and Items into Other Programs
You can use Copy Special to copy a formatted event or address to the Windows Clipboard 
for pasting into other Windows applications.  The event or address will be copied to the 
Clipboard in the standard Windows text format.

Cut, Copy, and Paste
The Cut, Copy, and Paste functions are available only for individual fields in entrybars and 
details dialogs.  Stay Organized Quick & Easy cannot cut, copy, or paste entire events or 
address.  See above for information on copying to other programs.

Previewing Alarm Sounds and Default Alarm Sounds
The Options dialog has a Demonstrate button that lets you preview each alarm sound 
available in Stay Organized Quick & Easy.  The Options dialog is also used to set the default 
alarm sound.

Keyboard Scrolling
Use the Arrow keys to scroll by event.  Use Ctrl + Arrow keys to scroll by individual lines of 
text.



Selecting To Do Rollover Options
Stay Organized Quick & Easy has several different options for automatically handling to do 
item rollover.  To do items rollover when their due date has passed.  You can use the Options
dialog to choose your preference.

Sorting and Special Characters
The Address Book displays all entries sorted into A through Z.  Entries that begin with 
numbers or punctuation are placed into the beginning of the A pages.  Entries that begin with 
international characters are placed into an equivalent A through Z page.  

The Address Book sort order depends on the language you have currently installed using the
Control Panel.   The Windows default is English (American).  If you have a number of entries 
that contain international characters, you may wish to use English (International).

Miscellaneous

Alarms and Alarm Sounds
Stay Organized Quick & Easy must be running in order for alarms to go off.   You can choose
Hide When Minimized in the Options dialog and Stay Organized Quick & Easy will hide its 
icon when you minimize the main window, but will still be running in the background and 
alarms will still go off.  To bring Stay Organized Quick & Easy back, choose “Stay Organized 
Quick & Easy” from any running program’s System menu.  

The alarm sounds in Stay Organized Quick & Easy depend on the PC speaker.  Drivers 
installed in Windows and variances in speakers can stop the alarm sounds intermittently or 
completely.

Attached Files and Default Attached Files
Attached files let you add items from one or more files to your current file, for viewing and 
printing.  You cannot edit or drag-and-drop items that are stored in attached files.  The default
attached files are the list of files that will be automatically attached to a newly created file.  
Changing the default attached files in the Options dialog will not affect any existing files.

Serial Number
The serial number is displayed during installation.  The serial number can also be found in 
About Stay Organized Quick & Easy under the Help Menu.

Printing Repeating Event Bars
If you choose the Monthly Planner layout (in any size), you may see an event printed within a
horizontal bar, this is called a repeating event bar.

A repeating event bar appears on the Monthly Planner if you have already set an event to 
repeat over consecutive days, such as Monday through Friday or a Saturday and Sunday.  

Important Note:  In order to see the repeating event bar, you must set the event as repeating 
by choosing the REPEAT button from the Details dialog.  If you have simply entered the 
event for each day, then the repeating event bar is not displayed.  

Changing Repeating Events



Once you have set an event or to do item to repeat over a sequence of days, this sequence 
cannot be changed.  You need to delete the event or to do item and then re-enter it with the 
new repeating sequence.

Setting Stay Organized Quick & Easy Date and Time Formats
Stay Organized Quick & Easy has several different date and time formats you can choose.  
Use the Options dialog to choose your preference.

Setting Windows Date and Time
Stay Organized Quick & Easy relies upon Windows having the correct date and time.  You 
can use the Control Panel to set the system date and time.

Contacting Technical Support

If you are having problems running Stay Organized Quick & Easy, there are several things you 
can do to efficiently get back under way.  Please go through the following checklist before calling
technical support.

If you cannot figure out how to do something
-  Read through the Stay Organized Quick & Easy User’s Guide.  
-  Go to the On-line Help (press F1) and read the related topics.
-  If you still cannot figure something out, call, fax or email Individual Software’s Technical 
Support department.

If you are having problems installing or running Stay Organized Quick & Easy▯▯
-  Make sure you are using Windows 3.1 or above.
-  Make sure your computer meets the minimum system requirements previously listed.
-  Make sure you have properly installed Stay Organized Quick & Easy.  Refer to the Stay 
Organized Quick & Easy User's Guide. 
-  Try reinstalling Organized Quick & Easy, paying close attention to the installation instructions 
and any error messages that are displayed.
-  If the program is not working properly with your printer, modem or other hardware, check to 
see if your other applications are working properly.

All customers who have sent in their registration card are entitled to technical assistance.  
Individual Software’s Technical Support can be obtained by phone, fax or email.  Before you 
call, please be at your computer and have the following information available for the best and 
most timely assistance.

What’s wrong?
· What exactly were you doing?
· What exactly were the error codes?
· Does the problem occur regularly?
· Did you install any new software?

What hardware do you have?
· Processor speed (486 DX33, Pentium 100, etc.)
· Amount of RAM (8MB, 16MB, etc.)
· Brand of computer and brand and model of printer



How To Contact Technical Support
Individual Software Inc.
5870 Stoneridge Dr., #1
Pleasanton, CA  94588-9900

Hours:  8:00am - 5:30pm Pacific Time, Monday - Friday

Phone:  (510) 734-6767
Phone:  (800) 331-3313
Fax:  (510) 734-8337
E-mail:  techsupport@individualsoftware.com
World Wide Web Page: http://www.individualsoftware.com

Please include the product name, a detailed description of the problem, your computer system 
information, and a daytime phone number.

Offering Suggestions About Stay Organized Quick & Easy

We are always open to your comments and suggestions on how we might improve Stay 
Organized Quick & Easy to better suit your needs.  Please direct your comments to the Stay 
Organized Quick & Easy Product Manager at:

E-Mail 75201.375@compuserve.com
FAX (510) 734-8337
Phone (800) 822-3522


